
SmarTek Systems Equipment Price List
Trichord, Inc. - New York State Contract No. PC60689

Note:  Items added under current (11/04) update listed in red
SmarTek Manufactured Items Distributed by Trichord

Item
Item                

Part Number
NYS                

Discounted Price

T-Box Micro-Processor
T-Box Standard Configuration TR-1 $2,352.00
T-Box with Integrated FrameGrabber and Video 

Input for 6 Cameras TR-1 Vid $3,430.00

Video Frame Grabbers
FrameGrabber FG PC104 $1,200.50

Power Supplies
PUP 30 120VAC for T-Box PUP30 $102.90
120AC/12vdc 800ma P5 120/12ACDC800 $19.60
120AC/12VDC 500 mA Adapter 120/12ACDC500 $18.03
12VDC 2A UnReg 120/12ADCC2A $36.75

Video Switch
Video Switch, 8 Camera Input VID-SW $563.50

Acoustic Multi-lane Traffic Monitor
SAS-1 SAS-1 $3,018.40
SAS-1 Wireless Option (plus SAS-1 above) SAS-1 Wireless $749.70
     Excludes Optional Antenna and Mount per site spec. listed separately below

Antenna Options
SAS-1 Internal Drop down Wire anntenna SAS Int Ant $24.50
YAGI 13.5 dB Antenna, Cushcraft YAGI $153.86
Maxrad Fiber Omni Whip Ant, 8 dB Whip-8db $146.80
Maxrad Fiber Omni Whip Ant, 4 dB Whip-4db $104.37
Astron Low Profile "Disc" Antenna, CDPD PCNLP-08V $77.42
Astron Low Profile "Disc" Antenna, 2.4 Ghz PCNLP-24V $77.42
Astron Dual Band Antenna for CDMA Modem NP8619TNXXF $156.60
Cirronet Corner2414 Corner2414 $220.50
Cirronet Omni249 Omni249 $222.26

Wireless Components Part Number
SAS- RFM External Base Station (Plus Whip antenna above) SAS-RFM $1,171.10
PSX Series in line surge protector PSX $93.10
SAS-1 Internal Wireless Option (plus SAS-1) SAS-1 Wireless $749.70
SAS- RFM External Remote SAS-RFM $1,078.00
PSX Series in line surge protector (Optional, Ant. Dep.) PSX $93.10
SAS RFM Remote CT RFM-CT $53.90
SAS RFM-CT Base Station Termination RFM-CT $53.90
SAS RFM-CT Base Station Termination 170 RFM-CT-170 $57.82
Wireless IP Radio Modem SEM2411X SEM2411X $1,763.02
Wireless IP Radio Power Module SEMPOWER $63.70
WirelessIP Data Cable (100 ft) SEMCABLE-100 $235.20
WirelessIP Data Cable (200 ft) SEMCABLE-200 $470.40

SAS Relay Interface Components
SAS-RI Type 170 Relay Interface for SAS1 SAS-RI-170 $220.50
SAS-RI Type 170 Relay Interface Daughter Card SAS-RI-DAU $53.90
SAS-RI Shelf Mount for NEMA hookup SAS-RI-SHELF $220.50
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SAS CT Cabinet Termination Options
SAS CT cabinet termination- 170 Card SAS-CT-170 $57.82
SAS CT cabinet termination- 170 Card (Rev 2) SAS-CT-170-2 $97.80
SAS CT cabinet termination- 170 Card (Rev 3) - Avail. Jan 2005 SAS-CT-170-3 $95.40
SAS CT PCB, Mounted SAS-CT $49.00
SAS-CT Shelf (Rev 2) SAS-CT-2 $102.43
SAS-CT Shelf (Rev 3) - Avail. Jan 2005 SAS-CT-3 $100.03
SAS NEMA Base Station Termination NEMA-CT $49.00
SAS-1 JB  Junction Box
     SAS JB Small w/ 3/4" Saddle SAS-JB-Small $44.10
     SAS JB LARGE SAS-JB-Large $66.15
     SAS JB Large (Rev 2) SAS-JB-Large-2 $90.00

 Mounting Equipment for SAS-1
PELCO 0326-23 Mounting Tube SE-0326-23 $14.70
PELCO SE-0111 Flat surface mount flange SE-0111 $11.76
PELCO SE-0454  4" Pole Flange SE-0454 $11.76
SAS Flange 4" Pole Thread Flange (PBH-425) PBH-425 $11.76
SAS Tube 17 ( P17 Threaded 80 Gauge Aluminum Pipe) SAS Tube 17 $11.76

Cabinets and Components
Pole Mount Boxes

NAZTECH Type II Control Cabinet with Pole Mount brackets NAZTECH Cab $441.00

Internal Components Part Number
Video surge protectors ( TRIPP LITE D10B2) D10B2 $34.30

Sensor Interfaces
STS USI2K Universal Serial Interface USI2K $646.80
STS BL2000 Process w/Relay Control BL2000 $665.42
STS Cabinet Watchdog CWD $245.00
STS Cabinet Power Relay Module PRM $161.70
CT / CWD Cable $25.20

Modems
Airling Raven II CDPD RAVEN II $568.40
Airlink Redwing CDPD REDWING $470.40
Airlink Raven CDMA w/ DC Power Cable RAVEN-CDMA $681.11
     120v DC to AC Adapter 120-100-1011 $16.20
STS Land Line Modem (POTS) DCModem $343.00
StarComm StarPoint Modem (POTS) Min Qty 20 $294.00
StarComm StarPoint AMPS module Min Qty 20 $588.00
StarComm StarPoint CDPD module Min Qty 20 $588.00
StarComm StarPoint CDMA module Min Qty 20 $799.93
TRIPLITE DTEL2 Telephone Surge Protector DTEL2 $32.83
RJ-45 CT to DB-9 Modem Cable CT2Modem $22.05
DB-9 to DB-9 (TBox to Modem) Cable NULL $19.11
SAS-CT TO PC serial cable CT2PC $22.05

Serial Port Ethernet Adapter and Server
Programmable IP address and data server
STS Device Server STS-DS1 $391.02
1 foot Ethernet Cable, RJ-45 to RJ-45 Cat 5 1Cat5 $4.90
3 foot Ethernet Cable, RJ-45 to RJ-45 Cat 5 3Cat5 $5.88

Power Components
AC-DC Adapters,Surge Strips, etc.

AC Surge protector/strip & 2 AC-DC Converters (redundant smaller ones rather than 1 
large big one) 2 AC-DC Convert $122.50
1 AC-DC convert with surge strip AC-DC Convert $98.00
SunSaver Battery Regulator SUN6 $58.80
SunSaver Battery Regulator SUN10 $90.00
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery, Deep Cycle Marine or Heavy Duty Auto $120.00
Battery Stand, 1/4" Aluminum BAT Stand $16.66
Battery Desulfanator DeSulf $87.22
Duplex outlet for 120VAC power DupOut $14.70
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GFI outlet, 2 Pos. 120VAC GFIOut $24.50
Uninteruptable Power Supply (UPS) Comercial Grade UPS $245.00

Optional Solar Power Supply with Battery Backup
80 Watt Solar Panel (expected to be typical) BP380 $391.02
Solar Panel Mount HPMV-80 $77.42
30 Wire Kit, Solar Panel Home Run OPWK10-30 $17.64
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Desulfanator DeSulf $83.30
Battery Stand, 1/4" Aluminum BAT Stand $16.66

RG-59 Cable Connectors RG-59Crimp $24.50
RG-59 Cable for Video Hook-up, $/ft. RG-59U $0.44
Beldon 9504 4PR, 1GND Foil Shield Cable, $/ft. Beldon9504 $0.49

Cameras and Accessories
Extreme CCTV EX-10 Color Camera EX-10C $792.00
Camera Junction Box CAM-JB $53.90
RG-59 cable assemblies RG-59 Cable $24.50
BNC to RCA Video Cable $17.77

Extreme CCTV EX-82 Camera
     Model EX82D8-V4 (4 to 8 mm lens -- wider angle) EX82D8-V4 $3,093.60
     Model EX82D-V6 (6 to 15 mm lens -- closer image, fixed lens) EX82D8-V6 $3,093.60
DiTek Video Surge Protector DTK-4TPV $98.66

Weather Sensors
Road Sensor with RS-485 Interface
     IRS-1 with 25m lead cable and two sub-surface sensors at 40 and 150cm 8410.02 $5,590.00
     IRS-21 with 25m lead cable 8410.00 $4,560.00
          50m lead cable option $210.00
          100m lead cable option $420.00
RS-485 / 232 Converter $560.00

Present Weather Sensor
     R2S with RS-485 Interface (includes 24v power supply and shield) 8367.01 $4,800.00
          25m lead cable option $105.00
          50m lead cable option $210.00
          100m lead cable option $420.00

RM Young Wind Monitor with Digital Interface
     Models 05103 and 32400, w/cable $2,124.00

1-Wire Systems Digital Environmental Sensors
     STP-1 Temperature Probe with Stainless Steel Tube $162.00
     1-Wire Relative Humidity Sensor $480.00
     1-Wire Wind Monitor $420.00

30-Foot Weather Tower
     Glen Martin Folding Tower with base, anti-climb barrier, & shipping to site MF-1330 $4,740.00

Labor
Trichord, Inc. or SmarTek Systems (hourly rate) LABOR $115.00
Labor for Provisioning CDMA Modems (per modem) CDMA-Labor $75.00

Technical Support
Depot Maintenance Support for CDMA Modems CDMA-Support $75.00

Wireless Communication Plans
Verizon Wireless CDMA Communication Plan (per month / unlimited data transfer) VW-Comm $80.00
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CONFIGURATION #1-170: See Catalog Pages 126-127
SAS-1 (hardwired) with Relay Interface
Type 170 Card File
> SAS Standalone sensor into a control cabinet
> AC Power to SAS-1 with Battery Backup, NY Cabinet
> Base:  NY State Supplied Cabinet, Controller, Power Supply & Card File (Type 170)

SAS-1 SAS-1
SAS Flange 4" Pole Thread Flange (PBH-425) PBH-425
SAS Tube 17 ( P17 Threaded 80 Gauge Aluminum Pipe) SAS Tube 17
SAS JB Small w/ 3/4" Saddle SAS-JB-Small
SAS CT cabinet termination- 170 Card SAS-CT-170
SAS-RI Type 170 Relay Interface for SAS1 SAS-RI-170
SAS-RI Type 170 Relay Interface Daughter Card SAS-RI-DAU

Final Bundle Price: $3,400.00

Beldon 9504 4PR, 1GND Foil Shield Cable, $/ft. Beldon9504 $0.49
     Usually sold in 500 & 1000 ft. rolls and cut on job site

CONFIGURATION #1-NEMA: See Catalog Pages 126-127
SAS-1 (hardwired) with Relay Interface
NO Card File into NY State Controller
Shelf Mount Relay Interface
> SAS Standalone Sensor into a control cabinet
> Base:  NY State Supplied Cabinet, Controller, and Power Supply

SAS-1 SAS-1
SAS Flange 4" Pole Thread Flange (PBH-425) PBH-425
SAS Tube 17 ( P17 Threaded 80 Gauge Aluminum Pipe) SAS Tube 17
SAS JB Small w/ 3/4" Saddle SAS-JB-Small
SAS CT PCB, Mounted SAS-CT 
SAS-RI Shelf Mount for NEMA hookup SAS-RI-SHELF

Final Bundle Price: $3,350.00

Beldon 9504 4PR, 1GND Foil Shield Cable, $/ft. Beldon9504 $0.49
     Usually sold in 500 & 1000 ft. rolls and cut on job site

BUNDLED CONFIGURATIONS
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CONFIGURATION #1-170 (wireless): See Catalog Pages 126-127
SAS-1 (wireless), Internal to SAS-1
Type 170 Card File
SAS-1 Relay Interface
> SAS Standalone Sensor Wireless Point-to-point Report to Base Station
> AC Power to SAS-1 with Battery Backup, NY Cabinet
> Base:  NY State Supplied Cabinet, Controller, Power Supply, and Card File

SAS-1 SAS-1
SAS-1 Wireless Option (plus SAS-1 above) SAS-1 Wireless
SAS Flange 4" Pole Thread Flange (PBH-425) PBH-425
SAS Tube 17 ( P17 Threaded 80 Gauge Aluminum Pipe) SAS Tube 17
SAS JB Small w/ 3/4" Saddle SAS-JB-Small
SAS CT PCB, Mounted SAS-CT 
SAS- RFM External Base Station SAS-RFM
PSX Series in line surge protector (optional, ant. dep.) PSX
SAS RFM-CT Base Station Termination 170 RFM-CT-170
Maxrad Fiber Omni Whip Ant, 4 dB Whip-4db
SAS-RI Type 170 Relay Interface for SAS1 SAS-RI-170
SAS-RI Type 170 Relay Interface Daughter Card SAS-RI-DAU

Final Bundle Price: $5,550.00

Beldon 9504 4PR, 1GND Foil Shield Cable, $/ft. Beldon9504 $0.49
     Usually sold in 500 & 1000 ft. rolls and cut on job site

CONFIGURATION #1-NEMA (wireless): See Catalog Pages 126-127
Multiple SAS-1 (wireless) with Relay Interface
NO Card File into NY State Controller
Shelf Mount Relay Interface
> 2 or more SAS-1, Sharing Common SAS-RFM and Remote Power
> Base:  NY State Supplied Cabinet, Controller, and Power Supply

SAS-1 SAS-1
SAS-1 Wireless Option (plus SAS-1 above) SAS-1 Wireless
SAS Flange 4" Pole Thread Flange (PBH-425) PBH-425
SAS Tube 17 ( P17 Threaded 80 Gauge Aluminum Pipe) SAS Tube 17
SAS JB Small w/ 3/4" Saddle SAS-JB-Small
SAS CT PCB, Mounted SAS-CT 
SAS- RFM External Remote SAS-RFM
SAS RFM Remote CT RFM-CT
SAS RFM-CT Base Station Termination RFM-CT
SAS- RFM External Base Station SAS-RFM
PSX Series in line surge protector PSX
Maxrad Fiber Omni Whip Ant, 4 dB Whip-4db
SAS-RI Shelf Mount for NEMA hookup SAS-RI-SHELF

Final Bundle Price: $6,650.00
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CONFIGURATION #1A-170: See Catalog Page 128
SAS-1 (hardwired) with Relay Interface
Type 170 Card File
> Base:  NY State Supplied Cabinet, Controller, Power Supply & Card File

SAS-1 SAS-1
SAS Flange 4" Pole Thread Flange (PBH-425) PBH-425
SAS Tube 17 ( P17 Threaded 80 Gauge Aluminum Pipe) SAS Tube 17
SAS JB LARGE SAS-JB-Large
SAS CT cabinet termination- 170 Card SAS-CT-170
SAS-RI Type 170 Relay Interface for SAS1 SAS-RI-170
SAS-RI Type 170 Relay Interface Daughter Card SAS-RI-DAU

Final Bundle Price: $3,400.00

Beldon 9504 4PR, 1GND Foil Shield Cable, $/ft. Beldon9504 $0.49
     Usually sold in 500 & 1000 ft. rolls and cut on job site

CONFIGURATION #1A-NEMA: See Catalog Page 128
SAS-1 (hardwired) with Relay Interface
Shelf Mount Relay Interface
NEMA or Shelf Mount Controller
> Base:  NY State Supplied Cabinet, Controller, Power Supply & Card File

SAS-1 SAS-1
SAS Flange 4" Pole Thread Flange (PBH-425) PBH-425
SAS Tube 17 ( P17 Threaded 80 Gauge Aluminum Pipe) SAS Tube 17
SAS JB LARGE SAS-JB-Large
SAS CT PCB, Mounted SAS-CT 
SAS-RI Shelf Mount for NEMA hookup SAS-RI-SHELF

Final Bundle Price: $3,350.00

Beldon 9504 4PR, 1GND Foil Shield Cable, $/ft. Beldon9504 $0.49
     Usually sold in 500 & 1000 ft. rolls and cut on job site

CONFIGURATION #1-170 (Fiber): See Catalog Page 129
SAS-1 (hardwired) with No Relay Interface
Type 170 Card File
Communication via Fiber Modem
> Base:  NY State Supplied Cabinet, Fiber Modems, Controller, Power Supply & Card File

SAS-1 SAS-1
SAS Flange 4" Pole Thread Flange (PBH-425) PBH-425
SAS Tube 17 ( P17 Threaded 80 Gauge Aluminum Pipe) SAS Tube 17
SAS JB LARGE SAS-JB-Large
SAS CT PCB, Mounted SAS-CT 
RJ-45 CT to DB-9 Modem Cable (price below includes 2) CT2Modem
SAS-RI Type 170 Relay Interface for SAS1 SAS-RI-170
SAS-RI Type 170 Relay Interface Daughter Card SAS-RI-DAU

Final Bundle Price: $3,450.00

Beldon 9504 4PR, 1GND Foil Shield Cable, $/ft. Beldon9504 $0.49
     Usually sold in 500 & 1000 ft. rolls and cut on job site
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CONFIGURATION #1-Fiber:
SAS-1 (hardwired) with Relay Interface
NO Type 170 Controller
Communication via Fiber Modem
> Base:  NY State Supplied Cabinet, Fiber Modems, Power Supply

SAS-1 (quantity as required) SAS-1
SAS Flange 4" Pole Thread Flange (PBH-425) (Qty. as Req'd) PBH-425
SAS Tube 17 ( P17 Threaded 80 Gauge Aluminum Pipe) (Qty. as Req'd) SAS Tube 17
SAS JB LARGE (quantity as required) SAS-JB-Large
SAS CT PCB, Mounted SAS-CT 
RJ-45 CT to DB-9 Modem Cable (1 req'd per site) CT2Modem

Final Bundle Price: $3,150.00

Beldon 9504 4PR, 1GND Foil Shield Cable, $/ft. Beldon9504 $0.49
     Usually sold in 500 & 1000 ft. rolls and cut on job site

(note:  Options below are NOT included in the Bundle Price)
Optional Site Pole Mount Cabinet
NAZTECH Type II Control Cabinet with Pole Mount brackets NAZTECH Cab $441.00

Optional Solar Power Supply with Battery Backup
80 Watt Solar Panel (expected to be typical) BP380 $391.02
Solar Panel Mount HPMV-80 $77.42
30 Wire Kit, Solar Panel Home Run OPWK10-30 $17.64
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Desulfanator DeSulf $83.30
Battery Stand, 1/4" Aluminum BAT Stand $16.66
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CONFIGURATION #2: See Catalog Page 130
SAS-1 (hardwired) Data Collection Site
Communications Options
> Base:  NY State Supplied Cabinet and Power Supply

SAS-1 SAS-1
SAS Flange 4" Pole Thread Flange (PBH-425) PBH-425
SAS Tube 17 ( P17 Threaded 80 Gauge Aluminum Pipe) SAS Tube 17
SAS JB LARGE SAS-JB-Large
SAS CT PCB, Mounted SAS-CT 
Interface Cable (depends on site connection):
SAS-CT TO PC serial cable or CT2PC
RJ-45 CT to DB-9 Modem Cable (1 req'd per site) CT2Modem

Final Bundle Price: $3,175.00

Beldon 9504 4PR, 1GND Foil Shield Cable, $/ft. Beldon9504 $0.49
     Usually sold in 500 & 1000 ft. rolls and cut on job site

(note:  Options below are NOT included in the Bundle Price)
Optional Site Pole Mount Cabinet
NAZTECH Type II Control Cabinet with Pole Mount brackets NAZTECH Cab $441.00

Communications Options
Airlink Redwing CDPD REDWING $470.40
DB-9 to DB-9 (TBox to Modem) Cable NULL $19.11
Astron Low Profile "Disc" Antenna, CDPD PCNLP-08V $77.42

Optional Solar Power Supply with Battery Backup
80 Watt Solar Panel (expected to be typical) BP380 $391.02
Solar Panel Mount HPMV-80 $77.42
30 Wire Kit, Solar Panel Home Run OPWK10-30 $17.64
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Desulfanator DeSulf $83.30
Battery Stand, 1/4" Aluminum BAT Stand $16.66
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CONFIGURATION #3: See Catalog Page 131
SAS-1 (hardwired) Traffic Information and JPEG Image Site
SAS-1 and Camera Inputs to T-Box
> Base:  NY State Supplied Cabinet, Power Supply, and Communication Option

SAS-1 SAS-1
SAS Flange 4" Pole Thread Flange (PBH-425) PBH-425
SAS Tube 17 ( P17 Threaded 80 Gauge Aluminum Pipe) SAS Tube 17
SAS JB LARGE SAS-JB-Large
SAS CT PCB, Mounted SAS-CT 
Extreme CCTV EX-10 Color Camera EX-10C
Camera Junction Box CAM-JB
RG-59 cable assemblies RG-59 Cable
Video surge protectors ( TRIPP LITE D10B2) D10B2
T-Box Standard Configuration TR-1
FrameGrabber FG PC104
STS Cabinet Watchdog CWD
STS Cabinet Power Relay Module PRM
SAS-CT TO PC serial cable CT2PC

Final Bundle Price: $7,750.00

Beldon 9504 4PR, 1GND Foil Shield Cable, $/ft. Beldon9504 $0.49
     Usually sold in 500 & 1000 ft. rolls and cut on job site

(note:  Options below are NOT included in the Bundle Price)
Optional AC to DC Power Supply Option with Battery Backup
AC Surge protector/strip & 2 AC-DC Converters (redundant smaller ones rather than 1 
large big one) 2 AC-DC Convert $122.50
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Desulfanator DeSulf $87.22
GFI outlet, 2 Pos. 120VAC GFIOut $24.50

Communications Options
Airlink Redwing CDPD REDWING $470.40
DB-9 to DB-9 (TBox to Modem) Cable NULL $19.11
Astron Low Profile "Disc" Antenna, CDPD PCNLP-08V $77.42
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CONFIGURATION #4: See Catalog Page 132
SAS-1 (hardwired) Traffic Information and JPEG Image Site
SAS-1 & Multiple Camera Inputs to T-Box
Other Sensors Optional
> Base:  NY State Supplied Cabinet, Power Supply, and Modem

SAS-1 SAS-1
SAS Flange 4" Pole Thread Flange (PBH-425) PBH-425
SAS Tube 17 ( P17 Threaded 80 Gauge Aluminum Pipe) SAS Tube 17
SAS JB LARGE SAS-JB-Large
SAS CT PCB, Mounted SAS-CT 
Extreme CCTV EX-10 Color Camera EX-10C
Camera Junction Box  CAM-JB
RG-59 cable assemblies  RG-59 Cable
Video surge protectors ( TRIPP LITE D10B2) D10B2
Video Switch, 8 Camera Input VID-SW
T-Box Standard Configuration TR-1
FrameGrabber FG PC104
STS Cabinet Watchdog CWD
STS Cabinet Power Relay Module PRM
SAS-CT TO PC serial cable CT2PC

Final Bundle Price: $8,300.00

Beldon 9504 4PR, 1GND Foil Shield Cable, $/ft. Beldon9504 $0.49
     Usually sold in 500 & 1000 ft. rolls and cut on job site

(note:  Options below are NOT included in the Bundle Price)
Optional Interfaces to Other Sensors (Temperature, Weather, Chemical, etc.)
STS USI2K Universal Serial Interface USI2K $646.80
(Must be programmed for specific device, separate estimate if not already completed)

Optional AC to DC Power Supply Option with Battery Backup
AC Surge protector/strip & 2 AC-DC Converters (redundant smaller ones rather than 1 
large big one) 2 AC-DC Convert $122.50
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Stand, 1/4" Aluminum BAT Stand $16.66
GFI outlet, 2 Pos. 120VAC GFIOut $24.50

Communications Options
Airlink Redwing CDPD REDWING $470.40
DB-9 to DB-9 (TBox to Modem) Cable NULL $19.11
Astron Low Profile "Disc" Antenna, CDPD PCNLP-08V $77.42
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CONFIGURATION #4A: See Catalog Page 133
Traffic Information and JPEG Image Site
Data Collection Hub with Multiple Camera Inputs to T-box
Other Sensors Optional
> Base:  NY State Supplied Cabinet, Power Supply, and Modem

SAS- RFM External Base Station SAS-RFM
PSX Series in line surge protector PSX
SAS RFM-CT Base Station Termination RFM-CT
Maxrad Fiber Omni Whip Ant, 4 dB Whip-4db
Extreme CCTV EX-10 Color Camera EX-10C
Camera Junction Box CAM-JB
RG-59 cable assemblies RG-59 Cable
Video surge protectors ( TRIPP LITE D10B2) D10B2
Video Switch, 8 Camera Input VID-SW
T-Box Standard Configuration TR-1
FrameGrabber FG PC104
STS Cabinet Watchdog CWD
STS Cabinet Power Relay Module PRM
SAS-CT TO PC serial cable CT2PC

Final Bundle Price: $6,550.00

(note:  Options below are NOT included in the Bundle Price)
Optional Interfaces to Other Sensors (Temperature, Weather, Chemical, etc.)
STS USI2K Universal Serial Interface USI2K $646.80

Optional AC to DC Power Supply Option with Battery Backup
AC Surge protector/strip & 2 AC-DC Converters (redundant smaller ones rather than 1 
large big one) 2 AC-DC Convert $122.50
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Stand, 1/4" Aluminum BAT Stand $16.66
GFI outlet, 2 Pos. 120VAC GFIOut $24.50

Communications Options
Airlink Redwing CDPD REDWING $470.40
DB-9 to DB-9 (TBox to Modem) Cable NULL $19.11
Astron Low Profile "Disc" Antenna, CDPD PCNLP-08V $77.42
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CONFIGURATION #4B: See Catalog Page 134
Camera & Traffic Data Site Without SAS-1 Input
Data Collection Site with Multiple Camera Inputs to T-box
Other Sensors Optional
> Base:  NY State Supplied Cabinet, Power Supply, Modem, Existing Traffic Loops & ADR-3000

STS USI2K Universal Serial Interface USI2K
Extreme CCTV EX-10 Color Camera EX-10C
Camera Junction Box  (Qty. as Req'd) CAM-JB
RG-59 cable assemblies  (Qty. as Req'd) RG-59 Cable
Video surge protectors ( TRIPP LITE D10B2) D10B2
Video Switch, 8 Camera Input VID-SW
T-Box Standard Configuration TR-1
FrameGrabber FG PC104
STS Cabinet Watchdog (opt) CWD
STS Cabinet Power Relay Module (opt) PRM
SAS-CT TO PC serial cable CT2PC

Final Bundle Price: $5,800.00

(note:  Options below are NOT included in the Bundle Price)
Optional Interfaces to Other Sensors (Temperature, Weather, Chemical, etc.)
STS USI2K Universal Serial Interface USI2K $646.80

Optional AC to DC Power Supply Option with Battery Backup
AC Surge protector/strip & 2 AC-DC Converters (redundant smaller ones rather than 1 
large big one) 2 AC-DC Convert $122.50
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Stand, 1/4" Aluminum BAT Stand $16.66
GFI outlet, 2 Pos. 120VAC GFIOut $24.50

Communications Options
Airlink Redwing CDPD REDWING $470.40
DB-9 to DB-9 (TBox to Modem) Cable NULL $19.11
Astron Low Profile "Disc" Antenna, CDPD PCNLP-08V $77.42



SmarTek Systems Equipment Price List
Trichord, Inc. - New York State Contract No. PC60689

Note:  Items added under current (11/04) update listed in red
SmarTek Manufactured Items Distributed by Trichord

Item
Item                

Part Number
NYS                

Discounted Price
CONFIGURATION #4C: See Catalog Page 135
Data Collection Site with Multiple Camera Inputs to T-box with Integrated Video Switch and Framegrabber
Other Sensors Optional
> Base:  NY State Supplied Cabinet, Power Supply, Modem, Existing Traffic Loops & ADR-3000 or use of SAS-1 sensors for traffic data

STS USI2K Universal Serial Interface USI2K
Extreme CCTV EX-10 Color Camera EX-10C
Camera Junction Box  CAM-JB
RG-59 cable assemblies  RG-59 Cable
Video surge protectors ( TRIPP LITE D10B2) D10B2
T-Box with Integrated FrameGrabber and Video 

Input for 6 Cameras available 2003 TR-1 Vid
STS Cabinet Watchdog (opt) CWD
STS Cabinet Power Relay Module (opt) PRM
SAS-CT TO PC serial cable CT2PC

Final Bundle Price: $5,100.00

(note:  Options below are NOT included in the Bundle Price)
Optional Interfaces to Other Sensors (Temperature, Weather, Chemical, etc.)
STS USI2K Universal Serial Interface USI2K $646.80

Optional AC to DC Power Supply Option with Battery Backup
AC Surge protector/strip & 2 AC-DC Converters (redundant smaller ones rather than 1 
large big one) 2 AC-DC Convert $122.50
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Stand, 1/4" Aluminum BAT Stand $16.66
GFI outlet, 2 Pos. 120VAC GFIOut $24.50

Communications Options
Airlink Redwing CDPD REDWING $470.40
DB-9 to DB-9 (TBox to Modem) Cable NULL $19.11
Astron Low Profile "Disc" Antenna, CDPD PCNLP-08V $77.42



SmarTek Systems Equipment Price List
Trichord, Inc. - New York State Contract No. PC60689

Note:  Items added under current (11/04) update listed in red
SmarTek Manufactured Items Distributed by Trichord

Item
Item                

Part Number
NYS                

Discounted Price
CONFIGURATION #5: See Catalog Page 136
Site with Existing Loops, Camera & Traffic Data Site w/o SAS-1 Input
Data Collection Site, No Video, Option ADR-3000 Shown as Loop Interface
Other Sensors Optional
> Base:  NY State Supplied Cabinet, Power Supply, Modem, Existing Traffic Loops & ADR-3000

STS USI2K Universal Serial Interface USI2K
STS Cabinet Watchdog CWD
STS Cabinet Power Relay Module PRM
SAS-CT TO PC serial cable CT2PC

Final Bundle Price: $1,075.00

(note:  Options below are NOT included in the Bundle Price)
Optional Site Pole Mount Cabinet
NAZTECH Type II Control Cabinet with Pole Mount brackets NAZTECH Cab $441.00

Optional Interfaces to Other Sensors (Temperature, Weather, Chemical, etc.)
STS USI2K Universal Serial Interface USI2K $646.80

Optional AC to DC Power Supply Option with Battery Backup
AC Surge protector/strip & 2 AC-DC Converters (redundant smaller ones rather than 1 
large big one) 2 AC-DC Convert $122.50
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Stand, 1/4" Aluminum BAT Stand $16.66
GFI outlet, 2 Pos. 120VAC GFIOut $24.50

Communications Options
Airlink Redwing CDPD REDWING $470.40
DB-9 to DB-9 (TBox to Modem) Cable NULL $19.11
Astron Low Profile "Disc" Antenna, CDPD PCNLP-08V $77.42

Optional Solar Power Supply with Battery Backup
80 Watt Solar Panel (expected to be typical) BP380 $391.02
Solar Panel Mount HPMV-80 $77.42
30 Wire Kit, Solar Panel Home Run OPWK10-30 $17.64
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Desulfanator DeSulf $83.30
Battery Stand, 1/4" Aluminum BAT Stand $16.66



SmarTek Systems Equipment Price List
Trichord, Inc. - New York State Contract No. PC60689

Note:  Items added under current (11/04) update listed in red
SmarTek Manufactured Items Distributed by Trichord

Item
Item                

Part Number
NYS                

Discounted Price
CONFIGURATION #6: See Catalog Page 137
Camera & Traffic Data Site w/o SAS-1 Input
Data Collection Site, No Video, Option 2 Loop Detectors
> Base:  NY State Supplied Cabinet, Power Supply, Modem, Existing Traffic Loops & Loop Detectors

STS BL2000 Process w/Relay Control BL2000
STS Cabinet Watchdog CWD
STS Cabinet Power Relay Module PRM
SAS-CT TO PC serial cable CT2PC

Final Bundle Price: $1,075.00

(note:  Options below are NOT included in the Bundle Price)
Optional Site Pole Mount Cabinet
NAZTECH Type II Control Cabinet with Pole Mount brackets NAZTECH Cab $441.00

Optional AC to DC Power Supply Option with Battery Backup
AC Surge protector/strip & 2 AC-DC Converters (redundant smaller ones rather than 1 
large big one) 2 AC-DC Convert $122.50
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Stand, 1/4" Aluminum BAT Stand $16.66
GFI outlet, 2 Pos. 120VAC GFIOut $24.50
Communications Options
Airlink Redwing CDPD REDWING $470.40
DB-9 to DB-9 (TBox to Modem) Cable NULL $19.11
Astron Low Profile "Disc" Antenna, CDPD PCNLP-08V $77.42



SmarTek Systems Equipment Price List
Trichord, Inc. - New York State Contract No. PC60689

Note:  Items added under current (11/04) update listed in red
SmarTek Manufactured Items Distributed by Trichord

Item
Item                

Part Number
NYS                

Discounted Price
CONFIGURATION #7: See Catalog Page 138
Camera & Traffic Data Site w/o SAS-1 Input
Data Collection Site, No Video, Option 2 IDC TSR Counter Interface
> Base:  NY State Supplied Cabinet, Power Supply, Modem, Existing Traffic Loops & IDC TSR

STS USI2K Universal Serial Interface USI2K
STS Cabinet Watchdog CWD
STS Cabinet Power Relay Module PRM
SAS-CT TO PC serial cable CT2PC

Final Bundle Price: $1,075.00

Optional Site Pole Mount Cabinet
NAZTECH Type II Control Cabinet with Pole Mount brackets NAZTECH Cab $441.00

(note:  Options below are NOT included in the Bundle Price)
Optional AC to DC Power Supply Option with Battery Backup
AC Surge protector/strip & 2 AC-DC Converters (redundant smaller ones rather than 1 
large big one) 2 AC-DC Convert $122.50
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Stand, 1/4" Aluminum BAT Stand $16.66
GFI outlet, 2 Pos. 120VAC GFIOut $24.50

Optional Solar Power Supply with Battery Backup
80 Watt Solar Panel (expected to be typical) BP380 $391.02
Solar Panel Mount HPMV-80 $77.42
30 Wire Kit, Solar Panel Home Run OPWK10-30 $17.64
SunSaver Battery Regulator SUN6 $58.80
Battery, Deep Cycle PVX-1080T or 8A27 $156.80
Battery Desulfanator DeSulf $83.30
Battery Stand, 1/4" Aluminum BAT Stand $16.66

Communications Options
Airlink Redwing CDPD REDWING $470.40
DB-9 to DB-9 (TBox to Modem) Cable NULL $19.11
Astron Low Profile "Disc" Antenna, CDPD PCNLP-08V $77.42


